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Purpose 
If you are using ComicRack to organize your comic library there is sometimes the need to enter data 

based on rules. So you might want to set the series group to “Gotham” for all Batman books. Or you 

scraped your data from Comic Vine (using the excellent ComicVine Scraper) and discover that some of 

the information in the ComicVine database is not correct. So you want to set the publisher 

information for the first 200 issues of Walt Disney’s Comics and Stories to Dell instead of Boom. This 

plugin will complete all these tasks automatically. 

Please note: The Data Manager requires that you install ComicRack version 0.9.164 or higher! 
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Glossary 
An explanation of a few terms we will use frequently in this manual  

Ruleset A ruleset is a directive that tells the Data Manager what it shall do. A ruleset 
can be e.g.: 
If Series is “Batman” then set SeriesGroup” to “Gotham” 

A ruleset consists of rules and actions. 
 

Rule A rule is the “left” part of a ruleset (in this example: If Series is 
“Batman”). A Rule can consist of several conditions, e.g.: 
If Series is “Batman” and Publisher is “DC Comics” and Volume Is 

“1940” 

Action An action is the “right” part of a ruleset (in this example: Set SeriesGroup 
to “Gotham”). An Action can consist of several steps, e.g.: 
Set SeriesGroup to “Gotham” and set MainCharacter to “Batman” 

and set Genre to “Superhero” 

Ruleset Collection A ruleset collection is the collection of all your rulesets 

Tree view The tree view is the graphical display of your collection in the rule set editor. 
It is built similar to the Windows Explorer. This is an example for the tree 
view of a ruleset collection 
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Installation 
Download the latest version of the Data Manager from here. In ComicRack then select “Edit -> 

Preferences -> Scripts”. Click on “Install” and select the file you just downloaded. You have to restart 

ComicRack afterwards. 

Important: if you install the Data Manager plug-in over a previous version please don’t remove the 

older version (selecting “Edit -> Preferences -> Scripts -> CR Data Manager -> Remove”). Otherwise 

you will lose your previous self-defined rules for the Data Manager. Just install the newer version over 

the old one and you will be fine. 

Nevertheless it is highly recommended that each time before you install the Data Manager you 

should first backup the following files in the Data Manager folder 

(%appdata%\cyo\ComicRack\scripts\CR Data Manager) to a secure place: 

 dataman.dat – this contains your ruleset collection 

 user.ini– this contains your rule and action templates and some settings for the Data 

Manager 

  

http://code.google.com/p/cr-data-manager/downloads/list
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Usage 

Setting up the configuration 
Before you run the Data Manager for the first time you have to define your rules. Start the Data 

Manager from the context menu in the library browser or from the toolbar in ComicRack. The icon of 

the Data Manager is the yellow square one with the black flash symbol inside: 

 

When this dialog appears click on “configure …”: 

 

 

 

 

 

If you have not used the Data Manager before you will not see any rules because you have not yet 

defined any: 

 

 

 

 

 

 

 

 

 

Note: If you have used a previous version of the Data Manager your old configuration will 

be loaded automatically into the GUI. You don’t have to start from scratch! 

In the next steps you will learn how to create some simple but powerful rules. 
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How-to: Create a few simple (but powerful) rules 

Step 1: What shall your rules do? 

At first step you should take a bit of time to think about what your rules should do. Some people want 

to correct data they scraped from the ComicVine database into their books, others might want to 

automate the process of preparing their books before they are moved by the Library Organizer.  

Let’s start with the last example: A lot of people organize their books by Series Groups. Series Groups 

group several series with a similar content or main character or whatever. So you might want to use a 

Series Group “Gotham” for all books that are more or less located in Gotham and a Series Group 

“Metropolis” for all the Superman books.  

This would make it easy to later organize your books in folder structures like this: 

 

In this example we would like to organize our books by the main character. The next step 

demonstrates how to prepare your rules so that your books can easily later on organized by the 

Library Organizer in this main character structure. 
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Step 2: Understanding the GUI editor window 

To create your first rules open the the configuration editor via the “configure …” button as described 

above. You will see mainly three rather empty panels inside the editor. Let’s take a quick look at 

them: 

  

The treeview panel will later display the list of the rules you defined. 

The groups panel helps you organizing your rule sets by placing them inside groups. 

The rules panel lets you create your rules. 
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To give you an idea how this window looks like once you created and organized your rules see this 

example: 

 

Looks quite nice and organized, doesn’t it? So let’s get on to the next step where you finally build 

your first rules. 

 

Step 3: Build your rule set 

A rule set contains of two parts. Part one defines the rules or criteria the Data Manager uses to 

decide which books shall be treated. Part two defines the actions which Data Manager should make 

based on your rules. 
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Part 1: Define the rule 

Now we want to build our rules. First we want to define that all books that have “Batman” in the 

series title should get the entry “Batman” in ComicRack’s Main Character field. 

Click on the “Add” button below the rules panel: 

 

 

 

 

 

After that the skeleton of your first rule is displayed in the rules panel. Click in “Name” field and give 

this rule a meaningful name (that will make it later on much easier to find it): 
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Now take a look at the treeview panel and notice that your rule is attached there. Click on it and the 

editor gives you the interface to finally enter your rule: 

 

Remember: our rule shall be “all books with Batman in the Series title”. So select “Series” in the first 

dropdown box below the rules panel. Select the range modifier “Is” and enter “Batman” as the value. 

Finally click “Add”: 
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Your rule is now displayed in the rules panel: 

 

But it seems we made a mistake: if we use the modifier “Is” this rule would only select the books 

where the exact series title is “Batman”, but not also “Batman: The Dark Knight”, “Batman and Robin” 

and so forth. In this case the range modifier “Contains” is exactly what we need. To correct that you 

only have to select “Contains” in the second dropdown box below the rules panel and click on 

“Update”: 

 

You can also add more criteria to one rule: maybe you want to be sure that only the Batman books 

should be handled by this rule that are published by DC Comics, simply select the Batman rule in the 

treeview and add this rule: 
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Part 2: Define the Action 

Now we define what shall happen with these books. It is done in a similar way like we created the 

rule above: Below the “Actions” panel you define what value will be set (in this case 

“MainCharacterOrTeam” shall be set to “Batman”). Click on “Add” afterwards: 

 

That’s all. Even with this very small rule set you could later on set the MainCharacter field for 

hundreds of books to “Batman” (where it fits) with one mouse click. Of course you can add hundreds 

of groups and thousands of rules to help you make organizing your library a lot easier. 

This was a very simple example but should give you an idea how to build rules with the Data 

Manager. 

Later on in this manual all fields and modifiers are further investigated.  

Note: To create further rulesets you do it like described above: select “Ruleset Collection” in the 

treeview panel, click on “Add” in the rules panel, give the rule a name and enter your criteria and 

actions. 
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Step 3: Save your hard work 

Now that you have done your hard work you should save the work you’ve done. Click on the “Save” 

button below the treeview panel. 

 

Note: If you ever notice that you made a mistake while editing your rulesets you can always 

revert to last saved status of your configuration by selecting the option “Revert” in the 

“File” menu below the treeview panel: 
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Step 4: Organize your rules (using groups) 

Once you created a lot of rules you will discover that it is quite hard to scroll through them to find the 

single rule you want to update or delete. Take a look at these two examples: the left one is quite hard 

to read, it is much easier to navigate and find what you are looking for in the example on the right 

side: 

  

This is where groups help to organize your ruleset collection. Groups in the Data Manager are like 

folders in the Windows Explorer: you use them to collect items.  
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So we assume that you have created three rules so far and you want to organize them in the folders 

“Main Characters DC” and “Main Characters Marvel”:

 

To achieve this you first have to select the location in the treeview panel where you want to create 

the group. As we currently have no further groups the only location possible is “Ruleset Collection”). 

Click on “Ruleset Collection” in the tree view panel and then on “Add” below the groups panel: 
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After you have given your group a name the 
treeview panel should look like this: 
 

 
Repeat the steps and create another group 
“Main Characters Marvel”. Don’t forget to click 
on “Ruleset Collection” because that is where 
you want to store your group! Your treeview 
panel should look similar to this now: 
 

 
To move your “Batman”, “Superman” and 
“Spider-Man” rules to the correct folder simply 
drag them with the mouse to that group and 
drop them there. Isn’t it simple? Afterwards your 
treeview panel should look like this: 
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Now your rules are finished and you can let the Data Manager do its job. 

Running the Data Manager 
After you edited the configuration you select the books that the script should handle in the 

ComicRack browser. Only the books you selected will be treated by the Data Manager: 

 

Now click icon in the ComicRack toolbar 
(Remember? It is the square yellow 
symbol with a black flash): 
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When asked if you want the Data 
Manager to run, click on Yes: 

 
 

Once you clicked on it the Data Manager will edit the selected books in your library according your 

rules configuration on the fly. This is the result; the Data Manager actually set the field “Main 

Character” of all the books you selected to “Batman” (where it fits!). 

 



The CR Data Manager Manual v4.0 Page 21 

 

You may click on yes to take a look at the log file which tells you what data was altered by the Data 

Manager. A sample log file will look like this: 

 

The Data Manager will only modify the books you have selected in the ComicRack browser. You don’t 

have to be afraid that it will affect your whole library (unless you have selected all books in your 

library, of course). 

Please note: you can always roll back the modifications to your library done by this script by selecting 

the “Edit -> Undo” command in ComicRack after you ran the Data Manager: 
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Why you should run the ComicVine Scraper before the Data Manager 
You might get unexpected results when you run the Data Manager on books that have not been 

scraped by the ComicVine scraper or have uncommitted values (so-called “Shadow values”). These 

uncommitted values will not be recognized by the Data Manager. So it is highly recommended to 

scrape the books first and afterwards additionally select “Automation -> Commit proposed values”.  

Also: if you use the Library Organizer plug-in you should run the Data Manager on your books before 

that. The Data Manager will help you a lot to set the metadata of your books to be handled by the 

Library Organizer properly. A good rule is to run the standard ComicRack plug-ins in this order: 

1 run ComicVineScraper 

2 commit proposed values 

3 run Duplicates Manager / Scan Info from Filename / More Scan Info from Filename 

4 run Data Manager 

5 run Library Organizer  



The CR Data Manager Manual v4.0 Page 23 

 

Which data fields can be used by the Data Manager? 
To see what fields can be used by the Data Manager simply open the ruleset editor and click on the 

dropdown lists below “Rules” or “Actions”: 

 

Using Custom Fields 
Custom fields were implemented in ComicRack  version 0.9.164. You can use these custom fields in 

the Data Manager rules and actions too. To use a custom field select “Custom” from the field 

dropdown list, enter the name of your custom field, select the modifier and enter the value to use: 
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Advanced features 

Combining Criteria 
The simplest way to define a rule is a rule like this: 

 

Which means: select all books where the word “Batman” is the series name. But sometimes you want 

to be more specific. So maybe you only want to set the series group of the “Star Wars” series to 

“Marvel Cosmic” if the publisher is Marvel. In this case you have to enter both criteria (Series is “Star 

Wars” and Publisher is “Marvel”). The complete rule would be: 

 

Combining criteria with ‘OR’ 
By default all your criteria are treated like combined with a logical AND operator. That means all 

criteria must be fulfilled for a rule to be executed. With version 1.2 the Data Manager also supports a 

simple ‘OR’ mode to combine your criteria. To use OR to combine your criteria open the Rule Mode 

dropdown list in the rules panel and select “OR”: 
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Note: These criteria are always treated like combined with a logical AND operator. That 

means all criteria must be fulfilled for a rule to be executed. 

Using Modifiers 
In the previous example above we have set the series group of all issues of any series named 

‘Batman’ to ‘Gotham’. This would edit data in all books where the series is exactly ‘Batman’ but would 

ignore all series like ‘Batman: The Dark Knight’. You can use modifiers to select books in a more 

specific way. So if you want to select all books where the word ‘Batman’ is somewhere in the title you 

would use the modifier ‘Contains’. The rule 

 

would select not only ‘Batman’, but also ‘Batman and Robin’ and ‘Adventures of Batman’. 

There are a lot more modifiers available than help to make your rules much more sophisticated. 

List of range modifiers in the “Rules” part of a ruleset 

These are the modifier that can be used to limit the books which the Data Manager should touch: 

Modifier Purpose Example 

Is select all books where the 
content of [field] is exactly like 
[value] 

 
selects all books which series is exactly “X-
Men” (but not “Uncanny X-Men”) 

Not select all books that would be 
excluded 

 

selects all books where the publisher is 
anything else but not ‘Marvel’ 



The CR Data Manager Manual v4.0 Page 26 

 

Range select all books in a given range 

(This will only work for the fields 
Number, AlternateNumber and 
numerical fields.) 

 

selects all books which number is in the range 
from 1 to 10 (including).  

NotRange select all books that are not in 
given range 

(This will only work for the fields 
Number, AlternateNumber and 
numerical fields.) 

 

selects all books which number is outside of 
the range 5 to 22. 

Contains select all books where the phrase 
is found somewhere in the field 

 

Selects all books where the series contains the 
word ‘Batman’ 

 

Selects all books where the exact phrase 
“Batman Robin” is somewhere in the series, 
but not where “Batman and Robin” is in the 
series field 

NotContains Select all books where the phrase 
is not found somewhere in the 
field (can only be used with non-
numerical fields) 

 

Selects all books where “Batman” is not found 
anywhere in the series. 

ContainsAnyOf Select all books where any of the 
values is found somewhere in the 
field (can only be used with non-
numerical fields, the list of values 
must be separated by commas) 

 

Selects all books where Batman or Robin or 
Joker is found somewhere in the series. 
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NotContainsAny
Of 

Select all books where any of the 
values is not found somewhere in 
the field (can only be used with 
non-numerical fields, the list of 
values must be separated by 
commas) 

 

Selects all books where neither “Superman” 
nor “Batman” is found in the series. 

ContainsAllOf Select all books where all of the 
values are found somewhere in 
the field (can only be used with 
non-numerical fields, the list of 
values must be separated by 
commas) 

Use NotContainsAllOf or 

NotContainsAnyOf to negate 

ContainsAllOf. 

 

Selects all books where “Batman” and “Super” 
are found somewhere in the series. 

IsAnyOf Select all books where the field is 
exactly as one value from the list 

 

Selects all books where the series title is 
exactly “Batman” or “Superman” 

NotIsAnyOf Select all books where the field is 
not exactly as one value from the 
list 

 

Selects all books where the exact series titles 
is neither “Batman” nor “Superman” 

Greater select all books where the value is 
greater than the phrase (this can 
only be used with numerical 
fields) 

 

Selects all books where the number is greater 
than 10 

GreaterEq select all books where the value is 
equal or greater than the phrase 
(this can only be used with 

 

selects all books where the number is equal to 
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numerical fields) or greater than 10 

Less select all books where the value is 
less than the phrase (this can 
only be used with numerical 
fields) 

 

Selects all books where the number is less 
than 10 

LessEq select all books where the value is 
equal or greater than the phrase 
(this can only be used with 
numerical fields) 

 

selects all books where the number is equal to 

or less than 10 

StartsWith select all books where the value 
starts with the phrase (can only 
be used with non-numerical 
fields) 

 

selects all books where the series name starts 
with “Bat” (like Batman or Batwing) 

NotStartsWith select all books where the value 
does not starts with the phrase 
(can only be used with non-
numerical fields)  

selects all books where the title does not start 
with “Batman” or “Superman” 

StartsWithAnyOf Select all books where the value 
starts with any of the given 
phrases (can only be used with 
non-numerical fields, the list of 
values must be separated by 
commas) 

 

Selects all books where the Series starts with 
either ”Super” or “Bat”. 

NotStartsWithAnyOf Select all books where the value 
does not starts with any of the 
given phrases (can only be used 
with non-numerical fields, the 
list of values must be separated 
by commas) 

 

Selects all books where the Series does not 
start with either ”Superman” or “Batman”. 
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Important Note: The Number field problem 

As ComicVine (as does ComicRack) allows any characters in the Number field of an issue (like ½, ∞ 

and everything else unthinkable) it cannot be guaranteed that range modifiers like Range, Less, 

Greater etc. work correctly with the Number field.  

If you have a simple “equal” comparison like Number = 1AU or Number = XV your rule will work as 

expected, but as soon you use range modifiers like Range, Less or LessEq, Greater or GreaterEq the 

results may be unexpected for books with “unconventional” numbers. So, if you use a rule like  

 

the Data Manager will find all issues with issue number 0, 0.5, 1, 2, 3 up to 10. But it will not find the 

roman numeric literal V. 

List of value modifiers in the “Actions” part of a ruleset 

These are the modifier that can be used set new values: 

Modifier Purpose Example 

SetValue sets the new value 

 

Sets the field Format to the new value “TPB” 

Calc perform calculations (see 
example below) 

 

Replaces the current number of the book with 
current number minus 1. But take care if the 
book’s number is no real numeric value 
(something like ‘∞’ or ‘1AU’ etc.). This might 
but must not lead to unexpected results. You 
should test rules on these values carefully. 

For more information about the Calc modifier 
please read the chapter “Field Variables and 
Calculations”. 
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Add add a new value to a field of type 
string (including multi value 
fields) 

 

Adds the tag “Metropolis” to a book 

Replace replace a value in a field of type 
string (including multi value 
fields) 

 

Removes “Metropolis” from Tags and adds 
“Superman” instead 

Remove remove a value from a field of 
type string (including multi value 
fields) 

 

Removes “Metropolis” from Tags 

RemoveLeading Remove a value from a the 
beginning of a field 

 
Removes a leading “The” from the series 
name. This way you can e.g. change the Series 
“The Incredible Hulk” to “Incredible Hulk” 
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Field Variables and Calculations 

Using field variables 

You can also use the content of fields to use in another field. So you may want to add the filename of 

the book to the Notes field. 

In this case in the action panel you select “Notes” as the field and “Add” as the modifier. Now you 

open the dropdown menu in the value field and select “{Publisher}” from the list: 

 

The rule => <<Notes.Add:{Publisher}>> will be added to your ruleset collection and when the Data 

Manager later runs over your books it will put the value of the Publisher field (“Marvel” or “DC 

Comics” or whatever) into the Notes field. 

Calculated values 

A very powerful feature of the Data Manager plugin is the use of calculated values in the “Actions” 

part of a ruleset. 

Take this example: One of the most notorious incorrect information on ComicVine is the 

“integration” of the 1999 volume of Amazing Spider-Man as issues 442 to 499 into the 1963 volume. 

How can the DataManager help to enter the correct information into your library? 
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It is quite simple: First you have to select the incorrectly dated books in your library. Our rule is: select 

all books where the series is “Amazing Spider-Man” volume “1963” where the number is in the range 

from 442 to 499 (including). The rule condition would be: 

 

Now we have to define what needs to be corrected. We want to change the volume to 1999 and 

correct the issue numbers to 1 (instead of 442), 2 (instead of 443) etc. This means we have to deduct 

exactly 441 from the original number. So this would be the “Actions” part of your rule: 

 

When you use the Calc modifier simply right click into the value field and you can select the field you 

want to use in a calculation from a dropdown field list: 

: 
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String “Calculations” 

You can also use the Calc modifier to perform calculations based on strings. So e.g., if you want to 

write the Tags and the ScanInformation and some fixed string into the Notes field you will create an 

action like this: 

<<Notes.Calc:'Tags: ' + {Tags} + 'Scan Information: ' + {ScanInformation}>> 

Please note that if you want to use fixed strings in your calculation those must be included in 

quotation marks. 

If you want a line break between Tags and ScanInformation you can edit that action that it looks like: 

<<Notes.Calc:'Tags: ' + {Tags} + '\n' + 'Scan Information: ' + {ScanInformation}>> 

'\n' will be interpreted as a line break. Once the Data Manager executed that rule on your book the 

result will look similar to this: 
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Working with empty values 
The Data Manager allows the usage of empty values. You might want to use a rule to set the value of 

SeriesGroup to something only if the field MainCharacterOrTeam is empty. For this purpose you write 

this rule: 

 

Simply leave the test value empty and the script will look only for books where the Main Character 

field is empty. 

With the same logic you can remove values from fields. Suppose you want to remove the values from 

SeriesGroup you would use this in the Actions part of your ruleset: 
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Working with Rule and Action Templates 
When you create your rulesets you will discover that you often have to enter very similar rules. 

Assume that you create a lot of rules for Marvel main characters you want to define your ruleset that 

way that it also contains a condition like “Publisher Is Marvel”. Instead of adding this condition each 

time manually you can create a template and apply this template later to any ruleset you create. 

Creating a template from scratch 

We create templates in the “Template Manager” tab at the top of the Configuration editor: 

 

It is quite easy to create a reusable template: Change to the “Template Manager”, select the kind of 

template you want to create (in this case: a rule template), enter a name for your template and finally 

define the criteria in your template (here: “Publisher” is “Marvel”):
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Note: in the name of templates no blanks and equal signs (‘=’) are allowed. 

Applying a template 

Applying your template to another rule is easy. So we assume you have a rule “Series contains Hulk” 

and you want to apply a template. This is done in 3 simple steps: 

Select your rule in the treeview, right-click in the rule or actions panel and select “Apply Rule 

Template” and the template you just created. The template is immediately attached to your existing 

rule: 

 

Creating a template using an existing rule or action  

If you have already created a rule or action that you want to make available as a reusable template 

simply right click on the existing rule or action and select “Create … templates”: 
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Action Templates 

Action Templates are similar to Rule Templates but these work with the “Actions” part of a ruleset 

(remember: that is the part of a ruleset which tells the Data Manager what to do). Action Templates 

are created and applied like rules templates. 

The context menu in the tree view panel 
You can right-click any item in the rules or actions panel to open the context menu with useful 

operations for the item that is currently selected. 

 

Copy: copies the selected group, rule or action to the Windows clipboard 

Copy all: copies the complete select group, ruleset or actionset to the Windows clipboard 

Cut: copies the selected group, rule or action to the Windows clipboard and deleted the selected item 

Paste: paste the item which you just copied or cut at this position in the tree view structure 

Delete: delete the currently selected group or rule 

Export group (only available when a group is selected): creates a new ruleset collection from the 

selected group. You can later import this ruleset collection or share it at the ComicRack forum. Please 

note that this will export *all* the groups and rulesets inside the selected group. 
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The File Menu 

 

 
 

 
Don’t be afraid of all these confusing options: if 
you have only one configuration (ruleset 
collection) the only option you will ever use here 
is “Save” and “Settings”. 

The File menu below the tree view panel handles 
maily the loading and saving of ruleset 
collections: 
About: displays information about the Data 
Manager. 
Settings: define some settings how the Data 
Manager should work. See the description 
below. 
Save as Default: saves the current ruleset 
collection as the default (the one that Data 
Manager uses when it does its job) 
Save as …: saves the current ruleset collection 
under a different name 
Save: saves the current ruleset collection 
Import …: Imports another configuration file into 
the current configuration 
Merge …: You can load another ruleset collection 
and merge it with the current ruleset collection 
Revert: revert all modifications and return to the 
last saved state of the current ruleset collection 
Load Default Profile: loads the default ruleset 
collection 
Load …: load another previously saved ruleset 
collection to the tree view 
New: empties the tree view so you can start 
from scratch creating your rulesets. 
 

 

Important note: The Data Manager takes care that your default ruleset collection is always backed up 

to a safe place but  it cannot be guaranteed that other files you generate via the save and export 

options will not be overwritten the next time you install an update of the Data Manager. So it is highly 

recommended that you store those files to a different location than the Data Manager directory!  
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The Settings Dialog 
The Settings dialog lets you set some settings for the Data Manager. Select the “File -> Settings” to 

open it: 

 

 

Confirm Overwrite of Default Profile: Every time you save the default ruleset collection to disk you 

are asked if you really want to overwrite the existing version by default. If you don’t want to be asked 

each time you can deactivate this option. 

Show Startup Dialog: When you start the Data Manager via the ComicRack toolbar icon you are asked 

if you want to start the Data Manager or want to cancel or want to run the configuration GUI. 

Deactivate this option and when you start the Data Manager the next time that dialog will not open 

again. 

Halt execution on error: sometime your action rules cannot be interpreted correctly. Check this 

option if you want to stop the Data Manager as soon as such an error occurs. Otherwise it will 

execute all rulesets after the ruleset where the error occured. 

Date/Time output format: When you are using a field variable to store a date to another field the 

format of that date will be a long format with date and time. You can define how the format should 

look like. A tooltip on this field in the Settings dialog displays the format options you can use: 
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So if you want that date values will be written in a format [Year]-[Month]-[Day] you must enter the 

expression “yyyy-MM-dd” into the output format field. This will format the date “March 15, 2013” to 

“2013-03-15”. 
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About the order of rules 
The Data Manager will work on your books in the exact order of rulesets as they are displayed in the 

tree view. See this example 

 

 
Data Manager interprets this as: 
 
Step 1: use rulesets in “dummy for 
testing” 
Step 2: use rulesets in “run this first” 
Step 3: use rulesets in “Legends of the 
Dark Knight 2012” 
Step 4 sequ.: use orphaned rulesets in 
“multiple volumes” 
 
 

That means that when you build your rulesets you should always be aware of the order of rules. 

Maybe you have a ruleset that sets a value in your books based on the condition that the SeriesGroup 

field is not empty you should place all your rulesets that fill the SeriesGroup field before that. The 

order of your rulesets should then look like this: 

1st ruleset: Set SeriesGroup to “Gotham” 

2nd ruleset: Set SeriesGroup to “Metropolis” 

3rd ruleset: Set SeriesGroup to “Blackest Night” 

Last ruleset: If SeriesGroup is empty, then add Tag “No SeriesGroup”   

Why the order of rulesets is important 

Example given, you want to set all books with “Annual” to the format “Annual” and remove “Annual” 

from the series name. Another thing you want to achieve is to set the SeriesGroup of all Series that 

contain “Batman” and “Annual” to “Gotham Annuals”. The 2 rules to accomplish that would be: 

<<Series.Contains:Annual>> => <<Series.Remove:Annual>> <<Format.SetValue:Annual>> 

<<Series.ContainsAllOf:Batman,Annual>> => <<SeriesGroup.SetValue:Gotham Annuals>> 

If you enter these both rules in exactly this order the second rule will not be executed because you 

already removed “Annual” from series of all selected books. And when the second rule is reached the 

Data Manager will not find any books where “Annual” is in the series. 
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So the correct order would be: 

<<Series.ContainsAllOf:Batman,Annual>> => <<SeriesGroup.SetValue:Gotham Annuals>> 

<<Series.Contains:Annual>> => <<Series.Remove:Annual>> <<Format.SetValue:Annual>> 

Changing the order of your groups and rulesets 

To change the order of groups and rulesets you can simply drag and drop them in the tree view to 

another location. 

Inside a group you can reorder the groups and rules with the help of the up and down buttons at the 

right of the “Groups in this group” and “Rulesets in this group” panel: 

 

The use of disabled rules 

You might want the Data Manager to exclude some of your groups or rulesets because you are testing 

something or simply want in the next run of the Data Manager some groups or rulesets excluded. In 

this case you will find the “Disabled Rules” in the tree view useful because every group or ruleset you 

drag and drop there will not be executed the next time the Data Manager runs. 

In the left example the rulesets in the group “Crossovers” will be executed. In the right example it will 

not: 

   

Later on you can simply drag it back to the Ruleset Collection and it will be executed again. 
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Searching and finding something in your ruleset collection 
If you have a huge ruleset collection it may be difficult to remember where you used a special field, 

modifier or value. Here the “Search” mode of the GUI will help you a lot. 

Select the “Search” tab above the treeview and rules panel: 

 

E.g. you want to find all rules or actions where “Spider-Man” was used as a value. In this case you 

enter “Spider-Man” in the value textbox and click on the search button: 

 

 In the lower part of the Search panel now all rulesets are listed where “Spider-Man” was used in a 

rule or action: 

 

Double click on the line you were looking for and the GUI will jump to the rule in the treeview panel 

where you can examine or edit it as described above. 

You can use any combination of fields, modifiers and values (and even regular expressions) to search 

through your ruleset collection.  Please note that if you use special characters (like ()*?[]+, etc.) in the 

values box they need to be escaped with a backslash (“\”) if you wish to find their literal value. 
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Performance Issues on Slower PCs 
With version 1.2 the Data Manager has been completely re-written to address performance issues. 

The Data Manager should run even over hundreds of books in just a few seconds. But it still may be 

possible that you will experience a performance decrease on a slower machine when your ruleset 

collection grows. Here are some best practices how to increase the speed of the Data Manager. 

Split your ruleset collections 

If possible split your very large ruleset collection into two or more. You might create one for your 

Marvel and DC books and one for all other publishers, e.g. 

Reduce the number of rulesets 

Regarding performance it may help a lot if you reduce the number of rulesets the Data Manager has 

to execute. Assume you have several rulesets that set the SeriesGroup to “Gotham” like: 

<<Series.Contains:Batman>> => <<SeriesGroup.SetValue:Gotham>> 

<<Series.Contains:Batwing>> => <<SeriesGroup.SetValue:Gotham>> 

<<Series.Contains:Robin>> => <<SeriesGroup.SetValue:Gotham>> 

<<Series.Contains:Joker>> => <<SeriesGroup.SetValue:Gotham>> 

These rulesets would be executed much faster if you combine them using the ContainsAnyOf modifier 

instead of Contains like: 

<<Series.ContainsAnyOf:Batman,Batwing,Robin,Joker>> => <<SeriesGroup.SetValue:Gotham>> 
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Links 
Discussion about the Data Manager in the ComicRack forum: http://comicrack.cyolito.com/forum/13-

scripts/30963-the-cr-data-manager-enter-data-automatically-based-on-rules-0112 

Downloads: http://code.google.com/p/cr-data-manager/downloads/list 

Any suggestions for new features and bug reports may be posted here: http://code.google.com/p/cr-

data-manager/issues/list 

The Data Manager has not been created to earn a living. But if you like to honor the effort and help 

keeping the Data Manager alive and progressing you are kindly invited to donate a few bucks here: 

https://www.paypal.com/cgi-bin/webscr?cmd=_s-xclick&hosted_button_id=YYDNBFQKCLAGQ 

http://comicrack.cyolito.com/forum/13-scripts/30963-the-cr-data-manager-enter-data-automatically-based-on-rules-0112
http://comicrack.cyolito.com/forum/13-scripts/30963-the-cr-data-manager-enter-data-automatically-based-on-rules-0112
http://code.google.com/p/cr-data-manager/downloads/list
http://code.google.com/p/cr-data-manager/issues/list
http://code.google.com/p/cr-data-manager/issues/list
https://www.paypal.com/cgi-bin/webscr?cmd=_s-xclick&hosted_button_id=YYDNBFQKCLAGQ
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License information 
The Data Manager for ComicRack is Copyright 2013 by docdoom. 

The Data Manager for ComicRack GUI is Copyright 2013 by T3KNOGhO57. 

Licensed under the Apache License, Version 2.0 (the "License"); you may not use the source code and 

software except in compliance with the License. 

You may obtain a copy of the License at http://www.apache.org/licenses/LICENSE-2.0 

Unless required by applicable law or agreed to in writing, software distributed under the License is 

distributed on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express 

or implied. 

See the License for the specific language governing permissions and limitations under the License. 

 


